
Win42
WIn42 plays the bidding-type game of "42", similar to spades or pinochle, except with dominoes. The 
computer plays three of the four positions, and you play the fourth.    You can also play against other 
people over the internet.    Besides being fun, it can be used to teach someone how to play, as 
suggested moves with explanations can be viewed. You can customize the look of the tiles by changing
their size and colors, as well as choosing (or creating) images for the back sides. Full-featured play has
most of the rule variations, including choices of forced dealer bid and whether/when to allow Nel-O play.
If you have a sound driver, you can hear comments from the players. Registered users also can replay 
hands, see statistics of how well you are making the different bids, save and open games, and save 
color changes. The help file is context-sensitive, and contains strategy tips as well as the basic rules.
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You can get updates to the game on the World Wide Web at the address 
http://members.aol.com/FREEWHL44/    .
Win42 is shareware.    If you continue using the program after initially evaluating it, you 
must register.



Trick
When all four players have played one domino, that set of four dominoes is called a trick.    
There are seven tricks in each hand, because each player is dealt seven dominoes at the 
beginning.    Each trick is worth one point, plus any count contained in that trick.



Count
Any domino with five or ten total spots is worth those five or ten points towards the bid.    
These dominoes are the double-five, six-four, five-blank, four-ace, and trey-deuce, and 
each is called "count."    There are 35 points from count dominoes, and one point for each 
of the seven tricks, giving a total of 42 points each hand.



Winsock
Winsock is a standard way of connecting to the internet from Windows - it's an adapted 
version of the Sockets standard that was created by UC-Berkeley.    It allows Win42, or any 
other internet application, to send and receive data in the same manner, no matter what 
kind of network interface you are using.    There will be a file called winsock.dll which takes 
requests from Win42 and then does the specific tasks that need to be done with your 
network connection.    This is a very useful standard that's been adopted by the computer 
folks.    The internet explosion wouldn't be possible without Sockets or something like it.



I.P. Address
To connect to other players, you need to know their I.P. address.    This is the address that 
uniquely identifies that network connection spearately from every other computer on the 
internet.    An I.P. address has the form of four numbers separated by dots, such as 
168.35.14.73 .    You can also use the computer name, which looks like 
joe243.saturn.iadfw.com .



Plunge
Plunge is a special bid where a person must have at least four doubles in his hand.    He 
bids 84, and then instead of calling the trump, announces that he is plunging, and his 
partner then calls the trump (variation: some people play Plunge for four marks - you can 
set this in Rule Options).    It's a good idea not to plunge if your partner neglected to bid on
his hand, because he'll have to have something to declare as trump.    The tricky point in 
playing a plunge hand is often when your partner has played all his trumps and must pass 
the lead to you, so you can lead your doubles.



Walker
When the leader leads a domino that is certain to catch the trick even though that domino 
is not a trump or a double, it is called a "walker," implying that it will walk around the table
without being stopped.    To be able to figure out if something will walk, you must keep 
track of all the dominoes played so far.



Off
The dominoes in the bidding player's hand that are neither trumps or doubles are called 
offs.    These are the ones that cause trouble for the bidder.



Suit
Dominoes are said to have "suits" similar to how cards have them. One end of the domino 
will determine its suit, while the other end is its rank in that suit.    But unlike cards, a 
particular domino may have one suit during this trick and another suit the next trick.    For 
example, the four-three can be of the "three" suit or the "four" suit, depending on what 
domino was led this trick.    There are seven dominoes of each suit.    Also, doubles can be 
declared as the trump, in which case they would be considered to make up a suit.



Doubles as a trump
If doubles are called as the trump, there are some things you need to be aware of.    As 
with other trumps, there are seven doubles.    But other aspects are different.
When you win the bid and call a regular suit to be trump, your hand will consist of trumps, 
doubles, and offs.    After you pull the trumps out of the other hands, your doubles are safe 
plays because nothing can beat them.    The only thing to worry about usually is your offs.
But when doubles are trump, all of the non-trumps are offs.    The only domino that can 
safely be played is the 6-5, and the 6-4 if you have both.    Be careful about bidding with 
doubles as trump, because with several offs, it makes it much harder.



Trump
The winner of the bid for each hand will declare a suit to be "trump."    If he has several of 
any suit in his hand, he may declare them to be trump, making them beat any other suit.    
As with all other suits, there are seven trump dominoes.
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Revision History

v2.03    Added a check button to test the network connection.    Fixed a bug that would make an internet 
"guest" confused when adding a third or fourth internet player, and it was a remote player's turn.    
Allowed a second "host" to connect to a guest and chat, but not play, so it will be easier to coordinate 
multiple-player internet games.    Added the option to disallow Plunge, or make it for two marks or 
four.    Allowed a "host" to begin a new game or replay a hand.

v2.01    With displays using a "Large Fonts" setting, the little box that asks for the bid and trump 
would be too short to hold all the stuff that's in it.    Fixed this.

v2.00    First release of internet playing.    This version also allows you to rearrange your hand while 
it's asking you for the bid or trump, and is smarter when playing Plunge.

v1.66    Made it a little smarter when the partner of a plunge bidder is calling the trump.    Now, it 
assumes that his partner will have the double of the trump suit.

Before, the person who bid plunge might slough off some of his lower doubles before sloughing an 
off.    Fixed this - the plunge bidder will always slough an off now.

When making an install disk for a friend, it might not realize it if the disk became full and some files 
couldn't be copied, and wouldn't report any errors.    Fixed this.

v1.65    Added "Rotate hands" option.

Pulled the hand-related menu items from the File and Options menu and made a new "Hand" menu.

When "Play all hands" is selected, made it ask you for each player's bid so you can override the 
computer's suggestion, especially when replaying a hand.

Fixed a bug that would prevent a computer player from trumping-in with a higher trump after 
someone else trumped-in already, even though the computer player would explain that he was trying 
to trump-in.

v1.61    Added the ability to print a registration form.

Made it less likely to bid plunge if the partner bid 42 or more.    This was because, if a partner had bid 
42 or 84 intending to go Nel-O, the partner likely has a poor hand instead of a good one.

v1.60    Made the game remember where the windows were placed last time, so that if you have a 
favorite way of arranging the score, pile, and table windows, you have to do it just once.

Changed the computer's bidding strategy.    Before, if it had a hand that was worth more than a 31 
bid, it might start at 33, or 34 on a really good hand.    Now it will bid 34 or 35 in those situations.

Fixed the minor bug that, if you replayed or re-started a hand, sometimes your hand would be 
missing a domino that you happened to be dragging at the first of the original hand.

v1.54    Added two new sound files - sixfour.wav and nickel.wav, and changed the program to know 
when to use them.

v1.52    Added the option when replaying a hand, to use the same bids from that replayed hand instead 
of bidding again.



v1.51    Fixed the display of previously opened files in the File menu.    Before, it would sometimes lose 
track of one of them.

v1.50    Added the choice to make the "Pile" dominoes be drawn larger.    This is especially for higher-
resolution monitors where the smaller ones are hard to see.

Enhanced the keyboard controls for those players who aren't using the mouse.    Now the Enter key 
will play a domino if you have only one legal choice, and the "/" or "?" key will show a suggestion.

v1.48    Allowed drawing dominoes after shuffling, immediately after the dominoes are drawn instead of 
having to wait for a fraction.    This also fixed a bug where if someone was really quick, he could draw 
a couple of dominoes when he was the one who shuffled, and therefore shouldn't be allowed to draw.

v1.45    Changed the game-saving method.    Before, it would save the old game when you exited or 
opened a new game.    Now, it asks you if you want it saved.    I did this because if you saved a hand 
that you wanted to play later, that hand would be overwritten with a later setup if you weren't very 
careful.

v1.4    History of open files was added. Now games are saved with the first name of the human player, 
plus the .42 extension.

Fixed the bug that would not allow you to bid plunge sometimes, namely when the computer's 
suggestion would have been Nel-o.

v1.3    "Doubles" as a trump was added back in.    It had actually been in an earlier pre-released version,
but I took it out because I didn't know how commonly it was allowed.

v1.2    In previous versions, if the shuffling process was interrupted to open a new game, start a hand 
over, replay a hand, or similar others, then things could get confused. This was fixed in this version 
by waiting for all event handlers to finish before processing the new interrupts.

v1.1    The ability to save the game setup and open it later was added. Also, when the game is exited 
the complete setup is automatically saved so that when the game is started again, you are right 
where you left off.

"Plunge" bidding was added.

v1.0    This was the original released version.
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Answers to Common Questions

Can the computer players see what is in my hand?

No, they don't look.    If they did, it would change the way the game is played.    You can go back and 
replay the hand, and see the reason each domino was played - the explanation doesn't depend on 
what anyone else has.

When I start the game, I see a message that the file CTL3DV2.DLL has not been installed 
correctly, but the game plays fine.    What's it mean?

CTL3DV2.DLL is a utility that makes some of the windows have a nice 3D-look.    To work correctly, 
that file must be in your \windows\system directory, and not in the same directory as the games.    
The included program install.exe is supposed to take care of this for you, as well as installing icons to
start the games in Windows.    If you skipped this step, then you can manually take care of this file by 
opening File Manager (in Windows 3.1) or Windows Explorer (in Windows 95), and dragging the file 
out of the directory with the games, into your system directory.    If the same or a newer version of that
file is already in your system directory, then just delete the one in the directory with the games.

When I draw a domino, am I really selecting the one I'll get?

Yes, both drawing to see who gets to shuffle first, and at the beginning of each hand, you decide 
which one you get.    Except in internet play - here it is pre-determined.
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Introduction to 42

42 is a domino game played predominately in the South central U.S., almost exclusively by adults. Its 
invention is credited to W. A. Thomas of Garner, Texas, about 1885 (according to the Goren / Hoyle 
Encyclopedia of Games). It's one of those few games that people can play their whole lives without 
tiring of it.    42 combines the strategy of bidding-type card games with the multiple-of-five concept of 
other domino games.

Although the rules for 42 are not very complicated, the strategy can be. It always seems that after a few
dominoes have been played, a good player knows which dominoes have not been played and who has 
them.    Playing against people like this can be intimidating to the novice, so it's my hope that you can 
use Win42 to learn to play with confidence.    The fun of 42 is in being bold with your bids and knowing 
how to make them.

42 is played pretty much the same everywhere, but there are a couple of minor variations.    Win42 lets 
you choose which you want to play (see Options for rule variations).



Win42
How to play 42

The game of 42 is similar to Bridge, Spades, and Pinochle, but played with dominoes.    
There are four players (two on each team), and each player bids on how many points he 
thinks he and his partner can score in one hand. There are seven tricks in each hand which
score one point each, and any domino with five or ten total spots scores face value. Thus 
the double-five and six-four are worth ten points each; the five-blank, four-ace, and trey-
deuce are worth five points each; these plus one point for each of the seven tricks make a 
total of 42 points in each hand (thus the name).
A player starts by bidding, saying how many points he thinks he and his partner can catch 
this hand.    Bidding proceeds around the table clockwise, until each of the four players has
had an opportunity to bid or pass.    The minimum bid is 30, so the first to bid will either bid
at least this much or "pass."    The next person must bid more than the highest so far, or 
pass.

Shuffling / drawing for down
Before play, you've got to decide who will be first to get the advantage of shuffling first.    
All the dominoes will be shuffled, and each person will draw one domino.    The person 
drawing the one with the most spots gets to shuffle first, and therefore bid last.    After the 
first hand, the shuffling honor will go around the table clockwise.    Then they will be 
shuffled again, and everyone who didn't shuffle takes seven dominoes, then the shuffler 
gets the remaing seven.

Starting Play
After the fourth person has had the opportunity to bid, play is started with whoever bid the
highest.    This person then declares which suit is trump (or calls Nel-O or Plunge), and 
starts play by leading one of his dominoes.    The other three players will in turn each play 
a domino.    When all four have played, the trick is collected by the winner, and this person 
leads the next trick.

Following Suit
The first domino played in each trick determines the suit for that trick, and each person 
must play a domino of that suit if he has one.    The suit is determined as follows:

- If the lead domino is a trump, then the suit for this trick is the trump suit.
- Otherwise, the suit is whichever end of the lead domino is greater.

If a following player can follow suit, he must.    If he doesn't have any dominoes of this suit,
he can play any domino.    If he plays a trump when a trump wasn't led, it is called 
"trumping-in," and any other domino is called a "slough."    Note, however, that a domino is
not considered to be a member of a suit if its other end is a trump.    For example, suppose 
that sixes are trumps, and someone leads a four when your only domino that has a four on
it is the six-four.    You are not forced to play it because it is a trump, not a four.

Determining a trick's winner
The highest domino of the lead suit wins a trick.    For example, if a four-blank were led, 
then the lead suit is a four.    If someone else has played the four-five, then it is higher than
the four-blank.    The double is always the highest of each suit, so the double-four 
would beat both.
However, if anyone has played a trump on this trick, then the highest trump wins instead.   
This is an important aspect of the game, that even though someone leads a double, the 



trick can be taken away from him by someone else trumping-in.
The winner of each trick collects the four dominoes and places them face-up together with 
any other tricks his team has won, and then leads a domino for the next trick.    All tricks 
are kept face-up on the table for everyone to refer to (except when 84 or more is bid, stack
the dominoes so that only the last two tricks are exposed to viewing).

Winning a hand
As soon as a team has collected enough points to make its bid, play is stopped and one 
"mark" is given to the bidding team.    If, on the other hand, the non-bidding team collects 
enough points so that the bidding team can't make it (42 minus the bid plus 1), play is 
stopped and that team is given a mark.    A whole game is won when a team has seven 
marks.



Win42
Bidding

Hands start with bidding, each player in turn saying how many points he thinks he and his partner can 
catch.    Bidding proceeds around the table clockwise, until each of the four players has had an 
opportunity to bid or pass.    The minimum bid is 30, so the first to bid will either bid at least this much or
"pass."    The next person must bid more than the highest so far, or pass.

When all four players have had an opportunity to bid, the highest is taken and all others are 
disregarded.    The bidding team will score one "mark" if the bid is made, and the non-bidding team will 
score a mark if it isn't.

Maximum bid

It's possible to catch up to 42 points in a hand.    However, a person can bid higher, saying that he will 
catch all the tricks, and risking more than one mark on the hand.    A bid of "84" means that his team will 
catch all seven tricks and will win two marks if successful, but lose two marks if unsuccessful.    If 84 has 
already been bid, someone can bid 126, risking three marks.    It's theoretically possible to have a bid of 
210, if the bids go 84, 126, 168, then 210.

These are the bids someone will do if playing one of the variations such as Nel-O or Plunge.Bidding 
Strategy

This is one of the toughest things for the novice, who always tends to pass or maybe bid 30 or 31.    In a
game of experienced players, it's very common to have bids of up to 35 or 36, sometimes even higher.   
My mother tells me that my grandfather hardly thought it was worth bidding unless you bid 34 or 35.    
These games are a lot more fun for everyone than when people sit around being timid.

So how do you know how much to bid?    There are 1,184,040 different arrangements of just your hand. 
Instead of thinking about how many points you can catch, think about how many points you might lose, 
then subtract that from 42.    In particular, look at how many tricks you might lose, and consider the 
count that they might contain.    The big ones are the 5-5 and the 6-4 - they are worth 10 points each.    
If you can't make sure you can catch both of these, then you'll likely lose one, and couldn't make any 
bid over 31.    If you do control them both, and would lose no more than two or three tricks, then it's 
likely that these tricks might contain only a five-count domino, so you could bid up to 42 minus 3 minus 
5, or 34.

Scan your hand, noticing which number you have the most of. Do you have the double? The next 
highest? Then look at the other dominoes. Do you have some doubles? Will they force count to be 
played? Then look at the others - your offs.    It's likely you'll lose these, so will they draw out count?    
How much?

Here's a way to think about it. Say you have the following:

If you win the bidding and call deuces as trumps, then you can play the double and the deuce-six, 
which will probably cause all the other players to play their collective four trumps. Then you've got a 
couple of doubles left, which you'll catch for sure. The 5-5 is worth ten points by itself. As for your two 
offs, the 5-3 isn't so bad, because it's protected by the 5-5, but the 6-1 ain't so hot. It's likely that you'll 
lose this trick, and it's likely to include the 6-4. Therefore you should feel pretty confident that you could 
catch all but eleven ( one trick including the 6-4 ), so you should bid 31 without batting an eye. You 



might even go higher to keep your opponent from winning the bid if you think he can make it.

If you had the above hand except for the 6-1, and had something else in its place that was neither a 6 
nor a 4, you should feel comfortable bidding all the way up to 35 or 36 (since you would probably still 
lose one trick, and that trick would likely have a five-count on it).

Remember that you have a partner and you don't have to catch them all yourself. Also remember that 
it's just as bad to lose because you let the other team have the bid, as it is to lose because you bid too 
high. In a competitive game of 42, people will make their bids a little more that half of the time. If 
someone wins almost every time he gets the bid, it's an indication that he's not bidding aggressively 
enough.

The balance point you're trying to find is to bid low enough that you can make it, but high enough that 
someone else won't overbid you.    Remember the big step going from 31 to 32 - you can't lose a ten-
count and still make 32.    But there's not much difference between 32 and 33, or even 34.    To make 
32, you can lose five tricks, one of which includes a five-count domino.    To make 33, you can lose four 
tricks and a five-count.    It's very unlikely that you could make exactly 32, but not 33 or 34.    So bid the 
higher numbers instead of letting someone else overbid you.    Try to remember, for each bid, how many
tricks and how much count you can lose:
30 two tricks, including one ten-count
31 one trick with a ten-count
32 five tricks with a five-count
33 four tricks with a five-count
34 three tricks with a five-count
35 two tricks with a five-count
36 one trick with a five-count
37 five tricks, no count
38 four tricks, no count
39 three tricks, no count
40 two tricks, no count
41 one trick, no count

Bidding on a "helping hand"

An advanced but common strategy is to bid low, not to win, but to signal your partner that you will be 
able to help him make a bid.    Of course, this works only if your partner has not bid yet.    If you have 
some doubles and/or a lot of count in your hand, but it's not a good hand to bid on, then bid 30.    If your 
partner knows what he's doing, he will interpret your bid to be a signal that you will be able to help him 
make his bid.    Be aware of this too, if your partner bids 30.

After play begins, you can also try to signal your partner about what he should play so that you can catch
a trick with one of your dominoes.    For example, if you don't have to follow suit and have the 6-6 and the
6-3, then by playing (sloughing) the 6-3, you can give your partner an indication that he should lead a six
for you to catch.    The reason this works is that normally you would be sloughing a very low domino, so 
when you play a heavier one like the 6-3, it should get his attention.    This is hit-and-miss kind of thing, 
but it does increase the odds of his being able to play something that you can catch.    If he's playing 
without knowing anything about what you have, then the odds are 2:1 against that you will be the one 
who wins the trick.
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Features of Win42 to help teach the game
Win42 has several features designed to help someone learn how to play 42.    The idea is to have a 
coach looking over your shoulder, recommending bids and plays, and letting you replay hands and 
switch dominoes with other players.

Suggesting plays

Anytime you would like to get a suggestion for which domino you should play, you can choose Suggest 
a play from the Options menu.    One of your dominoes will change to the highlighted color ( this color 
can be changed in the Options...    Colors menu ).    If you want to see why this domino was suggested, 
choose Explain suggestion.

As a shortcut, you can choose Options, Play Suggestions ->, Show help button.    This will cause a 
small button with a question mark to appear near your hand.    Click this button to highlight the 
suggested domino, and click it again to see the explanation.    This is the recommended setting for 
people who have learned the basics, since you will more likely think about the play before asking for 
help.

If you would like these suggestions to come up every time automatically, choose Auto-suggest plays.    
This will also bring up a status bar at the bottom of the window with the explanations.    This is the 
default way that Win42 starts after it is first installed, but is recommended only for people who are still 
learning the basics.    The trouble with this setting is that someone will just click the suggested domino 
without thinking.

Suggesting bids

You have similar options with bids as with suggested plays.    The recommended way is to choose 
Options, Bid suggestions ->, Show help button.    This way, you can think about the bid yourself but 
have convenient access to help if you need it.    However, if you find yourself pushing this button before 
thinking, you should instead select No hints.

If you choose Auto-suggest bids, then each time it is your turn to bid, the text box will be filled with 
Win42's suggestion.    If you want to change it, simply choose another number.    This is the default for 
Win42.    It's recommended for novices to intermediate players, because it discourages passing on 
decent hands, but can be a hindrance to learning if you rely on the suggestion without thinking about it 
yourself first.

Starting a hand over

If you make a wrong move and would like to start the current hand over, choose Start this hand over in 
the File menu.    The dominoes will be re-dealt as they were at the beginning of the hand.    Even if you 
have swapped dominoes between players before starting, it will go back to the arrangement that was 
done just prior to bidding.

Replaying hands

Win42 remembers the ten most recent hands since starting, along with who shuffled, who won the bid, 
and whether he made his bid or not.    If you would like to go back and experiment with a different 
strategy, choose Replay a hand... in the File menu. Replayed hands don't count towards the score, so 
you are free to go back several times to figure the best strategy for a hand.

Saving games

In addition to replaying hands (which don't count in the score), you can also save the game in progress 
so that you can come back to it later. When you open a saved game, you pick up right where that game
left off, including the overall game score. 



Swapping dominoes

If you want to experiment and see what would happen if your hand were different, you can move 
dominoes around between players by first choosing Show all hands in the Options menu, then using 
the mouse to drag a domino from one hand and drop it on the domino that you want to exchange with.

Keeping player statistics

Win42 keeps track of the number of hands and games each person plays and wins, and can display it 
by choosing File, View Player Statistics.... In addition, it keeps the number of times players have bid 
each possibility, and whether he made it.    Information is kept according to the name assigned to each 
player, so changing someone's name will have the effect of bringing in a new player with his own stats, 
while retaining the old player's stats still associated with his name.
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Using Win42
Win42 is designed to be intuitive to play by using the mouse to point to dominoes and drag them like 
you would the real thing.    However, some people, especially with notebook computers, prefer to do 
things with the keyboard when possible.    Here are some basic instructions for playing both ways.

Rearranging dominoes in your hand

With the mouse, click on one domino, and hold the button down while moving to another position.    The 
domino you selected will go to that position, and if a domino was already there, their positions will 
swap.
You may also click and release over the same domino to reverse it left to right.

Playing a domino

You can "drag" a domino, using the left mouse button, to the center area of the table.    If it is a legal 
move, then that domino will be played.    As a shortcut, you may also click a domino with the right 
mouse button to play it without dragging, or double-click it with the left button.

If you'd rather use the keyboard instead of the mouse, you can use the up / down / left / right keys to 
highlight the domino you want to play, then hit the Enter key.

Entering you bid

There are three ways to enter a bid; use whichever you find most convenient.

1. Type in a number using the keyboard.    To pass, you can enter 0, or just hit Enter with a blank 
entry.
2. Use the up and down arrow keys on the keyboard to scroll through the choices.
3. Click the drop-down arrow and make your selection with the mouse.

Hit Enter to accept your choice.

Selecting trumps

When you win the bidding, you are prompted to tell Win42 what trumps will be this hand. You may use 
any of the three methods listed above. You can enter the numerals 0 to 6, the words "blank", "zero", 
"ace", "one", "deuce", "two", "trey", 'three", "four", "five", or "six".    For other trump selections, "follow 
me", "no trump", and "nel-o" are also valid. For convenience, you need enter only the first two letters for
any of these.

Changing Colors

You can change the colors of just about all the elements of Win42 by selecting Colors in the Options 
menu. Select an element in the drop-down list box, the click on the color for that element with the 
mouse. You can also enter the red - green - blue values directly ( colors aren't redrawn until the cursor 
is tabbed out of a field ).
Win42 uses a 16-color palette, so colors besides Windows' standard set are drawn by dithering the 
color pattern. Outlines can be only from those 16 standard colors.

Domino back graphics

Win42 can place a graphic image on the back side of the dominoes.    You can even make your own 
graphics using a drawing program.    See Customizing the look off your dominoes for more info.

Player Names

You can change the name of any of the players in Win42 by selecting Player Names from the Options 
menu. It's more fun and easier to keep track if the names are someone you know.
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Options for Rule Variations

There are a few variations of how 42 is played.

If everyone passes...

You can select whether you want to re-shuffle when no one wants to bid, or force the dealer to bid at 
least 30. The force-bid rule has the emotional effect of making the person who shuffled stand behind his
work, as well as speeding the game up (especially with timid bidders who pass often). In case of a 
really lousy hand, you can allow him a way out by letting him bid Nel-O (to catch no tricks) on a force 
bid.

Allow Plunge...

You can choose whether to allow a person to bid Plunge at all, and if so, whether it's for two marks or 
for four marks.    If you allow it, I recommend you make it for two marks, because with the four marks 
option, a team that gets behind will tend to bid it out of desperation.

Allow Nel-O...

You can choose whether to allow a person to bid Nel-O anytime, never, or only for a dealer who has 
been forced to bid something. Nel-O play requires that only three of the four people get to play, there's 
not particularly much strategy involved, and Nel-O could be bid pretty often, so some people limit when 
Nel-O may be called.

The default way is to force the dealer to bid, and allow Nel-O on a forced bid.    If you make changes, 
Win42 will remember them next time you play.

Turn over dominoes when...

When enough points have been caught by the bidder to make the bid, or when they lose enough points 
that the bid can't be made, it's not necessary to continue playing any remaining tricks - the winner is 
already determined. Win42 will normally stop playing at that point and turn over everyone's dominoes 
for all to see, but if you would rather play out the whole hand to help you learn, you can set that option 
here.

Also, if one person has only trumps and/or doubles in his hand and no other players have any trumps, it
is guaranteed that he will catch the rest of the tricks. Win42 will normally stop playing at that point and 
let you know why, but you can choose not to do that.

Scoring systems...

Some people will keep track of the number of points scored from hand to hand, instead of scoring 
marks. Win42 does not do this particular scoring scheme.
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Special rules for Nel-O

If a player has a poor hand, he can choose to bid Nel-O, saying that he can avoid catching any tricks at 
all. If he catches even one trick, he has lost this hand. Listed below are some special rules for Nel-O 
play.

How to bid Nel-O

During the bid, a player going Nel-O doesn't indicate this fact. He must bid 42 (or 84 etc.), and if he 
wins the bidding, he then announces Nel-O. In Win42, you will tell the computer this by specifying Nel-
O when it asks you what are trumps. On the Score sheet, Nel-O will be listed as trump.

Bidder's partner lays down.

The partner of the Nel-O bidder doesn't get to play this hand. Instead he will lay his dominoes face-
down on the table.

Doubles are a suit of their own.

There is no trump in Nel-O play. Also, doubles are considered to be in a suit of their own.    This means 
that if a double is led, everyone must play a double if he has it. If a double is not led, he must play a 
domino of that suit other that the double if he has it. Playing a double when one was not led is a slough 
and will not win the trick.    Many people also allow doubles to be high in their suit (like normal) or low in 
their suit.    Win42 doesn't allow these (yet).

And of course...

Everything is backwards in Nel-O play. Instead of trying to win tricks, you try to duck below the highest 
domino.
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Pointers and strategy

Bidding strategy can be found on the Bidding page.

Leading

The strategy for leading is "Do what works." This can include many different kinds of play in various 
situations - there are 472,518,347,558,400 (almost half a quadrillion) different distributions of the four 
hands. That having been said, here's a basic strategy:
You usually want to start by forcing all the other players to get rid of their trumps, leaving you with at 
least one saved for the last trick. Then you can play your non-trump doubles, then your offs, then catch 
the last trick ( which will usually be rich in count ) with your remaining trump. If someone else has the 
highest trump at any time, the proper play may be to lead a low trump, forcing him to play it now, and 
then get the lead back later.
The perfect hand would be for you to lead your highest trumps, drawing out all the others while giving 
your partner an opportunity to slough off some of his count if he doesn't have a trump. You should save 
one trump for last. Then play your doubles, which you're guaranteed to win if no one else has trumps. 
Then lead an off for which your partner has the double. Most of the time, you won't be able to tell who 
has a particular domino, so there's only a one in three chance that your partner has it. For this reason, 
play an off that won't draw out count. In the ideal hand, your partner will catch that trick, then have a 
couple of more doubles to lead while you unload the rest of your offs. Then you'll catch the last trick 
with your remaining trump, and you've made 42!

Playing against the bidder

When the other team wins the bid, your control will be limited because you won't be deciding what are 
trumps. Hold onto any count you may have in your hand, and look for opportunities to take over the 
lead, or to throw out count when your partner is likely to catch a trick.
If you do get the lead, try to win count as soon as you can. For instance, if you have the double-five you
should probably lead that as early as you can. If you play it early, your opponents will be more likely to 
have a five and be forced to follow suit, instead of trumping-in. Pay close attention to how many trumps 
are left out and who has them.
When you have the opportunity to catch a trick, be mindful that you will lead the next trick. If a three is 
led and you have the 3-3 and the 6-3, then either one will catch the trick, but by saving the 3-3 you will 
have a good lead for the next trick. This happens pretty often, and is one of the fundamental differences
between 42 and bidding-type card games: each domino has two sides, and for each trick, one will be 
the suit, and the other will be the rank in that suit. But the next trick, the other end can be the suit.    This
doesn't happen with cards - with the Jack of Spades, the Spade is always the suit and the Jack is 
always the rank.

When count doesn't matter

Anytime either team is within one point of making what it needs to to win (equal to the bid for the 
bidding team, and 42 minus the bid plus one for the non-bidding team), count no longer matters 
because a trick won by that team will win them the game no matter what count it contains.    You might 
want to pause a minute to convince yourself of this.    This affects how you should play, because you 
should start holding dominoes that can catch tricks without regard to count. This will always be the case
whenever 42 or more is bid.

Playing against someone who bid 42 or more

If one of your opponents has won the bid for 42 or more and is not going Nel-O or Plunge, you should 
play a little bit differently. First, look at it from the bidder's point of view. He has enough trumps that he's 
not worried about losing any of those. He'll usually play all of his trumps first. After that, he has some 



doubles that you can't hope to catch after you're out of trumps. Finally, he has some offs. The seventh 
trick will probably be the one where the hand is decided. Any offs he has will likely be protected by a 
double (he uses the double of the lead suit to force everyone to deplete their hands of that suit, then no 
one can catch his lower domino of the same suit).
Since you will be sloughing mostly, you have an excellent opportunity to decide which dominoes you 
play without being forced to play certain ones by the leader. Be watching for what that off might be.    It's
very likely that the leader will play the double of that suit immediatley before playing the off, so any 
doubles that you have probably won't be useful. For the same reason, the other dominoes in your hand 
that are covered by doubles in your hand or doubles played earlier won't be useful.
Start the hand by looking for which ones you will be able to catch. There's no use worrying about the 
other suits if you won't be able to catch them, so prepare yourself for the ones you can get. Your partner
will be doing the same with some of his dominoes. Look for dominoes that you have that you have 
more than one of (to play when the leader plays his double). The 6-5, 5-4, and 4-3 have set many good 
84 hands.
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What you need to know to play real dominoes

Win42 captures the strategy of 42, but interacting with other people is a little different.    Here are some 
tips.

Decide on the rules you will use.

Since there are variations in what the rules are, avoid hurt feelings by agreeing up front what the rules 
are.    The things you should ask are: Is the dealer forced to bid if everyone else passes?    Is Nel-O play
allowed at all, is it allowed all the time, or only when the dealer is forced to take it?    Is plunge allowed, 
and for how many marks?    What about other variants such as "sevens" ?

Choosing teams and first to shuffle

You must have four people to play 42. If you don't already know how you want to pair up, you can draw 
for partners. Lay all the dominoes face-down on the table, and each person takes one and turns it over. 
Using the total number of spots on each one, the two highest will be partners, and the two lowest. To 
decide a tie, the people involved in the tie will draw again.
It's advantageous to be the person who shuffles, because that person will be the last to bid. Draw 
dominoes again, and whoever gets the highest shuffles first. After the first hand, the shuffling honor 
goes around the table clockwise.
Also, appoint one dependable person to be scorekeeper.

Shuffling and drawing your hand

To shuffle, stir the dominoes as they lie face-down on the table. Be sure to mix them up thoroughly. 
Then push them to the center of the table. Each person will draw seven dominoes. As a courtesy, the 
shuffler should not draw his own dominoes, but should wait and take the seven remaining after 
everyone else has drawn.
Stand your dominoes in a straight line in front of you on the table. Don't arrange them in an arc or your 
opponents will be able to see the ones on the ends.

Bidding

Whenever he is ready, the person to the left of the shuffler states his bid. If he wants to bid 42 or 84, 
many people just say "one mark" or "two marks," to make the arithmetic easier. Also, people when 
passing may say some other phrase such as "not me" or "go ahead."

No talking about what you have!

It is bad form to "talk across the table," saying anything that could give your partner an indication of 
what you have. There's plenty of other things to converse about.

Starting play

The person who wins the bid starts play by laying his domino near the middle of the table. Most of the 
time, he will play his double trump, in which case it is assumed that this will be the trump without 
explicitly saying so. If he plays anything else, he needs to clearly say what is trump. Many people add 
variety by saying something like "the little end" to indicate, for example, that blanks are trump when a 
four-blank is led.

Other players

After the lead, each person lays his domino near the middle of the table in clockwise order. Don't slide 
the domino across, because it can slide too far and knock over someone's hand. When real people 
play, they don't place their dominoes neatly like Win42 does, so you need to pay attention to who plays 
which. It's okay to ask if one slipped by you.



Gathering the trick

The person who wins the trick (or his partner) will slide them to a corner of the table and leave them 
face-up so that other players can see. All of a team's tricks need to be kept together; arrange them 
neatly four-across so that someone can tell what was played in which trick.    Exception - if the bid was 
84 or more, the tricks are stacked in the middle of the table, two tricks wide (first two tricks on the 
bottom, next two tricks on top of those, etc.), so players will have to pay more attention to what has 
been played.

Keeping track of the game

Win42 tallies the points won as the game goes, and always displays what are trumps and what the bid 
was. In a real game, you have to do this yourself.    Pay attention. Practice by playing Win42 with the 
Score window minimized to an icon. You should always know what trumps are, how many trumps are 
left out and who has them, and about how many points you and your opponents have. As you get 
better, you will also be able to tell who has what based on which dominoes he has played before. For 
instance, if a double-six is led and the next person plays the 6-4, it's a pretty safe bet that he doesn't 
have any more sixes. Remember that.
When a team has accumulated enough points to win, play is stopped there. Also, if it is certain that a 
player will catch enough points to win, he can lay his hand face-up and let everyone else see that he's 
won. Be sure before laying your dominoes down that it's really over.



Menus and Controls

To learn more about a command in one of the following menus, click its name.

File    New game, Save game, Save current game as, Open game, View player statistics, Exit, Open 
game history.
Hand    Start this hand over, Re-shuffle, Replay a hand, Rotate table, Show all hands, Play all hands.
Options    Player names, Colors, Rule options, Colors, Domino size, Pile domino size, Play speed, 
Begin network game.
Suggestions    Suggest a play, Explain suggestion, Play Suggestions, Bid Suggestions.
Help    Register, Contents, About Win42.



Win42
File menu

Save game...    Saves the current game to the name of the last opened game.

Save current game as...    Allows you to save the current game, including the distribution of all the 
dominoes, the names of the players, whose turn it is, and the current score. By default, the saved 
game file will have the extension .42. Use this feature to save a game for future reference, since the 
"Replay a hand" keeps only the last ten games, and forgets everything when you exit. You can also 
use this to e-mail a saved game, as the saved file is in plain text format. If you find a questionable 
strategy that Win42 used, send the file to Curtis Cameron at FreeWhl44@aol.com with a description 
of your question.

Open saved game...    This recalls a game that you previously saved. Only registered users can open a
saved game. However, if you save a game when you're not yet registered, you'll be able to open it 
after you register. 

New Game    Starts a new game, erasing any score so far in this game.    Selecting this will ask if you 
want to use a new player, and if so, will start a new game file, separate from the file you had been 
using with the old player.

View player statistics...    Win42 keeps track of the hands played by each player, along with how many
times he bid how much and whether he made it or not. Stats are kept according to a player's name, 
instead of what position he sits in. You can use this information to tell you if you are bidding often 
enough (the total number that you bid should be about a quarter of the total number of hands), and 
which of your bids you aren't making enough. Your success rate should run about 60 to 65%; lower 
and you're bidding too much for how well you can play, higher means that you could be bidding more 
and still winning.

Exit     Closes Win42 and the help file if it is open.
Open game history  The four previously open games will appear in the File menu, and you can get to 
any one of them by clicking it here.    Only registered users can open saved games.    Use this if more than
one person plays on the same computer, because each can quickly get his game back by clicking its 
name.
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Hand menu

Start this hand over    Re-deals the dominoes as they were at the beginning of the hand; only available
after bidding has started and until the hand is finished. Use this if you mess up and would like to start 
over. To play a hand that has been finished, use "Replay a hand" instead.

Re-shuffle    Deals a different hand of dominoes.

Replay a hand...    Brings up a window allowing you to replay any of the last ten hands. Select a hand 
and hit the Replay button, and the dominoes will be dealt as they were at the beginning of that hand.

Rotate table...    Brings up a window allowing you to rotate the table so you can play someone else's 
hand instead of your own.    This is especially useful when used in conjunction with the Replay option,
to let you replay a hand from someone else's point of view.

Show all hands    To better learn to play 42, you may want to play while looking at other players' hands.
If you select this option, then you will not receive credit for a won hand, but the other team will get 
credit for a hand they win (because the computer players never look at other hands). While other 
hands are being shown, you can swap dominoes with other players by dragging them with the 
mouse. Turning off this option will also turn off the Play all Hands option if it is turned on.

Play all hands    To study play more closely, you can select this option to allow you to bid and play each
domino for all four players. As the turn passes to a new player, the domino that he would have played
will be highlighted.    Also, if auto-suggestions are turned on in the Suggestions menu, then the 
reason for each suggestion will be displayed at the bottom of the Win42 window. Turning on this 
option will also turn on the Show all hands option.
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Options menu

Player Names...    The game is more fun if you can imagine playing against real people that you know. 
Select this menu item to change the names of any of the four play positions. You can either type in a 
new name or click the drop-down arrow to select a name that has been used previously. When you 
choose a different name, statistics are saved for the outgoing player and any existing stats are pulled 
in for the incoming player. If multiple people play Win42 on the same computer, then always selecting
your name when you play will keep your statistics separate from anyone else's.

Colors...    You can customize any of the colors used in Win42, to make it easier to read the dominoes 
for you or to look more like the dominoes you usually play with. Select an element whose color you 
want to change, and either click on one of the standard colors or enter the red - green - blue values 
for each in the range of 0 to 255. When you are entering a new number in a field, the color in the 
sample display will change when the cursor is moved out of that field either by clicking somewhere 
else or by hitting the Tab key.

The back side of the dominoes can also be customized by selecting a bitmap, icon, or metafile. If the 
picture is bigger than what will fit on the domino, only the top left portion will be displayed. You can 
use Windows' Paintbrush program to design your own graphic. Make the image size small enough to 
fit on the domino.    See Customizing the look off your dominoes for more info.

Rule Options...    You can select what happens when all four players want to pass when bidding. 
Choose either to force the last person to take it for at least 30, or re-shuffle the dominoes. Also select 
when Nel-O is allowed: either never, always, or only when the dealer has been forced to take the bid.

Sounds...    If you have a sound driver installed, Win42 can make realistic clicking sounds, and pepper 
the game with comments from other players. High-quality sounds are produced from sound cards 
such as a Sound Blaster, but there is also a driver available to make your PC speaker play sounds, 
though of a much lower quality. To set up a driver, go into Windows' Control Panel, then select 
Drivers. If you don't have the driver available for the PC speaker, it is widely available on on-line 
services.

Domino Size When Win42 is run for the first time on a computer (if the file win42.ini doesn't exist), it 
sets the domino size to be appropriate for the display resolution being used. If you would like to 
change the size, select one larger or smaller than the one currently being used. The size you pick 
must be able to fit on the Table; if it's not and you get a message, simply use the mouse to drag the 
Table's border to a larger size, and try again. On displays with lower resolution than 1024 by 768, you
won't be able to try the larger sizes.

Pile domino size    You can display the "Pile" of played dominoes either larger or smaller.    Default is 
smaller for VGA (640x480) resolution, and larger for higher resolution.

Play speed    The medium play speed simulates a delay between players but still is fast enough to hold 
your attention. If for some reason you would like to make it really fast, or fairly slow, then select that 
option here.

Begin network game...    This allows you to start an internet game.    Choose either "as a guest" or "as 
the host".
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Suggestions menu

Suggest a play    Select this option from the menu, or hit Ctrl-S, to see a suggested play when it is your
turn. The recommended domino will be highlighted. To see an explanation for why this domino was 
recommended, select Explain Suggestion.

Explain Suggestion    If you've asked for a suggestion and would like to see the reason, select this 
from the menu or just hit Ctrl-X.

Play suggestions    There are three choices here - Auo-suggest plays, where the suggested play will 
be highlighted automatically, Show help button, where a small button with a question mark will 
appear near you hand. Clicking it will highlight Win42's suggestion, and clicking it a second time will 
show the explanation. No hints will turn off the button. Choose this if you find yourself relying on the 
computer's suggestion without thinking about it.

Bid suggestions    There are three choices here, almost identical to the play suggestions. The same 
recommendations apply here too, except that a novice to intermediate player might want to auto-
suggest bids, if you might otherwise tend to pass.
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Help menu

Register Win42 is shareware.    This means that you can obtain the program for free, and give it to your
friends.    If you continue to use it after seeing what it can do, you are then expected to pay for it.    To 
find out exactly how this is done, read the Register help page.

Contents Select this to bring up the Contents page of Win42's help file, win42.hlp (you're reading that 
file now). You can also bring up the help file at any time while using Win42 by clicking the F1 key. 
Also, the F1 key is context-sensitive, meaning that it will open to the help page appropriate to what 
you are doing at the time.

About...    Displays a window with info about Win42.
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Registering

Win42 is shareware.    You can try it out for an evaluation period without it costing you anything.    If you 
continue to use the program, the license agreement between you and me says that you must then 
register by sending $15 U.S. to this address:

Curtis Cameron
1520 Glastonbury Dr.
Plano, Texas    75075

Also include your return e-mail address or postal address.

Win42 and Dominoes for Windows can be registered together for $25 instead of $15 each.

In addition to meeting the license terms, you will receive a "code word" which will make the program 
load much faster, and enable some of Win42's features which have been disabled.

This code word is specific to you - it is dependent on the spelling of your name, and when registered 
your name will appear on the opening title for Win42.    See Giving the program to your friends for 
information on which files to copy so that your name won't be on every copy that gets made after that.

When you receive your code word, go to the Register window by clicking Win42's Help, then click 
Register.    Enter your name, with the same spelling that is tied to your code word.    Capitalization or 
punctuation don't matter.    Then enter your code word and click the Register button.    From this point 
forward, the program will load much faster and all the features of Win42 will be enabled.

Future updates will be made available for downloading on the World Wide Web at the address 
http://members.aol.com/FREEWHL44/    .    You needn't worry about losing you registration if you get a 
newer version.
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Copying the program for your friends

Please give the program to as many people as you think might like it, and freely post it to bulletin 
boards and software libraries.    The easiest way to get the program to someone with access to the 
internet is to give him the address http://members.aol.com/FREEWHL44/    .    Getting the program this 
way requires some knowledge of how to unzip files and get around the PC's file system.    For the 
computer novice, it's easier to give him a floppy disk which takes care of those details.    Both Win42 
and Dominoes for Windows have a feature to allow you to make a fresh install disc that you can give to 
someone.    Choose Copy the program for a friend... in the File menu.    In order for this to work 
correctly, all the files that were installed on your computer originally must still exist.    Please don't delete
any of the files that were placed in the program's directory.    In addition, there are two files which are in 
the \windows\system directory.

 In the program's directory:
The following files should be together in their own directory.    When copied to the friend's computer, the 
install program will place them in a directory that is created just for Win42 and Dominoes.

win42.exe The program itself.
win42.hlp The help file (you're reading it now).
threed.vbx This is a library file that must be present for Win42 to run.    Some computers already 
have a threed.vbx file in their windows system directory, but it's a good idea to keep this one in the 
same directory as the program, since there are some minor compatibility problems between different 
versions.
cswscktl.vbx This is a library file that must be present for Win42 to run.    This one gives Win42 the 
capability to send data over the internet.
*.wav All file names with the .wav extension are the various clicks and sound effects.
*.bmp The files with the .bmp extension are the images that can be placed on the backs of 
dominoes.

In the windows system directory
These two files can be found in the windows system directory, ususally at the location \windows\system.

vbrun300.dll This file must be present for Win42 and Dominoes to run, but since many other 
programs also require the same file, keeping it in the system directory lets them all share the same 
copy, and uses less room on your disk drive.
ctl3dv2.dll This is another shared library file.    To work properly, it must be in the windows system 
directory, and not in the program's directory. 
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Customizing the look of your dominoes

In addition to changing the colors of the dominoes, you can really make them look like your favorite 
dominoes by selecting a different graphic image for their backs.    Win42 includes several bitmap (.bmp)
files for this purpose, including several college logos and some flags.

You can also use a bitmap or icon that you create using any drawing program.    I recommend Paint 
Shop Pro, available on the web at the address http://www.jasc.com/ .    The following information will 
help you if you want to make your own graphics.

Image Size 

Since you can make the dominoes larger or smaller, there are various image sizes that would be 
appropriate for them.    If the image is larger than what will fit on the back of the domino, then only the 
top left portion of the image will be used.    The maximum displayed area for each size of domino is:

Puny 41 wide x 19 tall
Smaller 47 x 22
Small 51 x 24
Medium 57 x 27
Sizeable 67 x 32
Grand 73 x 35
Immense 79 x 38

Image Types 

There are dozens of different formats for storing and image in a file.    The most common formats may 
be used as domino backs in Win42:

BMP      The Windows bitmap format is the most common for images in Windows. The Paintbrush 
program that comes with Windows saves its images in this format.

RLE      This format is similar to a BMP, but uses less disk space because the data is run-length 
encoded.    However, the files that are small enough to fit on the back of a domino don't take up 
enough disk space to be concerned with anyway.

ICO      This is the format for icons in Windows.    Icons are always 32 x 32 pixels, so they'll be cropped 
unless you're using the larger domino sizes.

WMF      Windows Metafiles are scalable images - a program can stretch and shrink them because 
instead of each pixel of the image being defined, the lines and shapes that make up an image are 
stored.    Windows doesn't come with any programs that can generate Metafiles, and they don't look 
all that great on the back of a domino.

Colors 

The images that come with Win42 are designed to be used on a white domino. If you would like other 
colors, then you can modify one with a drawing program, and make its background be the same color 
as the domino color you want.    Save the image either as a 16-color or a 256-color bitmap.



Win42
Contacting the author

If you find a problem or have questions about the game, please e-mail me at the address 
FREEWHL44@aol.com. I'd like to hear about any bugs or suspicious strategy that you might observe. 
Many times, I'll need to have the same setup that you saw to cause a problem. You can save a game 
(in the File menu), and paste the contents of that saved game file in your message. That file is simple 
text so that it will be easy to mail. Saved game files ususally will have the file name extension .42.



Win42
Playing with other people over the internet

Introduction

Besides being able to play against the computer simulating real people, this version will let you connect
to other people over the internet and play with or against them.    You can connect to one, two, or three 
other people, and the computer will still simulate any missing positions.    It's easy to set up, but you'll 
need to contact that person before connecting, to make sure you're both ready.    Once you've 
connected, you'll be able to send each other messages within the Win42 game.

What's Required

All that you need is to have an Internet Service Provider (ISP) or Online Service (such as America 
Online or CompuServe) which provides a Winsock-compliant network connection.    I'm not aware of 
any services that give you access to the internet which are not Winsock-compliant, so this should be 
easy.

Coordinating With Other People

Once you've made a connection to someone, you can chat with him through the Win42 game.    
However, before you make the connection, you'll need to coordinate with him so that you'll both be 
ready at the same time, and so that the person doing the connecting will know the correct address of 
the other's computer.    You can do this in several ways:

1. Send each other e-mail.
2. Talk to each other on the telephone.
3. Meet at a chat room.    There is a dedicated chat room for anyone wanting to play Win42.    You 
can also meet other people you don't know, and play a "pick up" game.    The address of the Win42
Chat Room is http://members.aol.com/FREEWHL44/win42chat.html .    You also will need to decide
whether you will be partners or opponents.

When you coordinate with someone, there needs to be one person as the "host", and the other players 
will be "guests".    Make the most computer-literate person the host.    Each guest will need to start 
Win42, and click Options, Begin network play, ...as a guest, and then tell the host what his computer's 
I.P. address is.

Making The Connection - The Guest's Role

For a guest, the connection process is very simple - you start Win42 and begin a network game as a 
guest.    You then need to tell the host your computer address, which will be displayed on the Network 
Connection window that pops up.    Then, just wait for the host to make the connection.    When he does,
the game that's current on the host's computer will appear on yours.    Also, the rule options that the 
host uses will be in effect, and you will be told what the rules are.    You'll be able to play the game just 
as you would without a network connection, but the plays for the other players will actually be coming 
from the host's computer.    When it comes time to hit the button to deal a new hand or to begin bidding, 
you won't see these (only the host does), so you will instead just wait for the host to hit the button on his
screen.    You can use the "Chat" area to send messages to the other players.

Making The Connection - The Host's Role

As a host, you will do the same, except you will begin a network game as host.    You will then see a 
setup area for each of the other three positions in the game.    To connect to a remote player, click the 
Setup button that corresponds to that position, and a box will pop up for you to enter the I.P. address of 
the guest.    Then click the Lookup button, and the I.P. address and computer name info for the guest 
should be displayed.    Next hit the Connect button.    You'll see a notice in the Chat area telling you that 



a connection has been established.    After this, you can connect to someone else, or just continue with 
the game.    When it comes to a remote player's turn, you'll probably notice a delay, mostly because a 
human doesn't play as fast as the computer does.

Registering and Network Play

To get the most out of the network capability of Win42, you should be registered.    If someone is not 
registered, then the network connection will automatically disconnect after seven hands.

Network Firewalls

Corporations and other large organizations will typically isolate the computers on their network from the
rest of the world with a network "firewall."    Two computers within that organization can talk to each 
other, but they are prevented from connecting to computers on the other side of the firewall.    This is 
done for the sake of security, so that an outsider can't have access to the organization's data.    There 
will be a few computers which can actually access the outside world, and the other computers will get 
access to the internet using one of these computers as a proxy.    Win42 is not able to use proxies, 
therefore you won't be able to connect two computers on opposite sides of a firewall.






